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I. PURPOSE 

 

 The Contractor Payment System Front End (CPSFE) personal computer program is one of the 

computer programs used to develop Final Engineer's Construction Estimates for the New Jersey 

Department of Transportation.  It is used by consultants and design units of the Department to 

create the data files needed by the Department to produce Final Engineer's Construction 

Estimates for Capital Program projects.  When the data files are complete they are uploaded by 

the Department to the CPS program on the mainframe to produce the contract documents. 

 

II. COMPUTER PROGRAM 

 

 The program has been designed as a WINDOWS based application, which can run under 

Windows 3.1 and 3.11, Windows 95 & 98, and Windows NT. These instructions have been 

written for Win95/98 or NT 4. It is a compiled FoxPro program, and supercedes the DOS 2.1 

version and the Windows Versions 1.0 and 1.1 versions. If you are currently running the previous 

Windows version, download the upgrade file.  The CPSFE Program Version 1.2 will allow users 

to prepare Final Engineer‟s Construction Estimates for both English and Metric projects.  This is 

accomplished by the user selecting the year of the Standard Specifications being used for the 

project which will, in turn, automatically indicate to the program which Standard Item database 

(1989 for English or 1996 for Metric) to use for the Engineer‟s Estimate. 

 

 The new features of this version are as follows: 

 

 The price field for an item has been increased to allow for a maximum unit price of 

$99,999,999.9999. 

 

 A drop down menu has been added in the Engineer‟s Heading File to indicate the year of 

the Standard Items to be used for the project, the Region of the State and the county or 

counties included in the project. 

 

 Instructions have been provided for Windows installation and a Windows Help menu is 

available inside the application. 

 

 A conversion option has been provided to convert CPS data created by CPS Program 

Version 2.1 for use with the new version. 

 

 The bid price report has been converted to a database and is used to assist the estimator 

in pricing. 

 

  CAUTION!  Data created by the DOS version of the CPS program will not automatically 

run in the new version because the base system has been converted to a windows format.  

Refer to Section VII of this manual for conversion instructions. 
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III. SOFTWARE 

 

The software package consists of the CPSFE Version 1.2 program files, and the Standard Item 

and Bid Price database files (supplied by the Department), and a data diskette (supplied by the 

user).  The CPSFE program is in a zipped file that are listed below, however, the software 

package obtained from the Department may be on individual diskettes. 

 

A. FILE SETS 

 

The four sets of files indicated below consist of the CPSFE program, Standard Item Files, Bid 

Price Files, plus a data diskette that is supplied by the user for storing the data files for the 

project.  These sets of files are as follows: 

 

1. PROGRAM FILES 

 

This zipped file named Cpsseteup.zip contains the executable program that installs the 

Engineer‟s Estimate System on the hard drive of the computer. 

 

The following are the files inside the zipped file: 

 

_MSSETUP.SU _MSTEST.EX_ 52192778.SE$ COMMDLG.DL_ 

CONFIG.FP$ CPSFE.EX$ CPSFE.IC$ CPSFE.IN$ 

CPSFE2.EX$ CPSHELP.HL$ DDEML.DL_ EARTH.BM$ 

FOXFONT.85$ FOXFONT.FO$ FOXPRINT.FO_ FOXPRINT.TT_ 

FOXPRO.IN$ FOXRUN.PI$ FOXTOOLS.FL$ FOXUSER.DB$ 

FOXUSER.FP$ FOXW2600.ES$ FOXW2601.ES$ FOXW2602.ES$ 

FOXW2603.ES$ LETGOT.FO$ LETGOT.TT$ LETGOTB.FO$ 

LETGOTB.TT$ LETGOTI.FO$ LETGOTI.TT$ MSCOMSTF.DL_ 

MSCULSTF.DL_ MSDETSTF.DL_ MSINSSTF.DL_ MSSHLSTF.DL_ 

MSUTILSTF.DL_ OLECLI.DL_ OLESVR.DL_ PROJECTS.CD$ 

PROJECTS.DB$ README.TXT SETUP.EXE SETUP.IN_ 

SETUP.INF SETUP.LST SETUP.MS_ SHELL.DL_ 

SKLALTER.DB$ SKLDELTAL.CD$ SKLDETAL.DB$ SKLQUANT.CD$ 

SKLQUANT.DB$ TOOLHELP.DL_ VER.DL_  

 

2. STANDARD ITEM FILES, MIXED SPECIFICATION YEAR 

 

This zipped file named StandardItemFiles.zip contains the Standard Item database files to 

be used for English or Metric projects and is necessary to run CPSFE.  The following are 

the files inside the zipped file: 

 

STANDITM.CDX  Index file for the database 

STANDITM.DBF  Standard item file in a database format 
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3. BID PRICE FILES, MIXED SPECIFICATION YEARS 

 

This zipped file named BidPriceFiles.zip contains the (Average Weighted) Bid Price 

database files to be used for English or Metric projects and is necessary to run CPSFE.  

The following are the files inside the zipped file: 

BIDPRICE.CDX  Index file for the database 

BIDPRICE.DBF  Bid Price Report in a database format 

 

4. DATA DISKETTE 

 

This diskette is a blank formatted diskette to be supplied by the user and used for data 

files.  A subdirectory is created using the DP Number XXXXX.  

 

The following are examples of the files that will appear in the Subdirectory XXXXX. 

 

ENGHEAD.DBF Database which holds the Engineer's Heading information 

for project XXXXX. 

DETAIL.DBF  Database that holds the Engineer‟s Category 

information for project XXXXX. 

DETAIL.CDX Index for the Engineer's Category database. 

QUANTITY.DBF Database that holds the Engineer‟s Quantity information for 

project XXXXX. 

QUANTITY.CDX Index for the Engineer's Quantity. 

LOWALTER.DBF Temporary database used in calculating the low alternates. 

 

CAUTION!  It is strongly recommended that only one project be placed on a data diskette 

since files do sometimes go bad.  Only one project would then be affected.  Secondly the 

system does not have the capability to determine when a diskette is about to fill up.  

Either case could cause considerable work in reentering the data for lost projects. 

 

B. OBTAINING SOFTWARE 
 

The software package for the Contract Payment System Front End is supplied by the 

Department and can be obtained as follows: 

 

1. FROM NJDOT Web Site 

 

Download Cpsseteup.zip, StandardItemFiles.zip, and BidPriceFiles.zip from the 

Department‟s Web Site (http://www.state.nj.us/transportation) and go to the Capital 

Program Management area, then the CPM Table ot Contents, then the Cost Estimating 

and Pricing Info area.  Download all three of these zipped files to the Temp directory in 

your PC‟s hard drive.  Check every two months for updates to the database files. For 

upgrading from previous Windows versions get the Cpsupgrd.zip file. 
 

2.  FROM DISK COPIES 
 

Those who do not have access to the Department‟s Web Site can obtain a disk copy of 

the software package directly from the Department.  The software package obtained in 

this manner consists of four separate diskettes and should be treated as an original copy. 
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When the software package is received, copy the files into the Temp directory on your 

hard drive and use for installation in accordance with Section IV of this Manual. 

 

IV. INSTALLING THE SYSTEM 
 

The System has been designed to operate from a hard disk only. The installation program 

included on the first zipped file will install the executable CPSFE program onto the hard disk. 

 

1. Unzip the Cpssetup.zip file in the Temp directory. (WinZip from www.Winzip.com is good) 

2. Select Start /Run in Windows. 

3. Type C:\temp\setup in the box and press enter. 

4. When the screen showing the target directory and Program Manager group appears, 

select Continue. 

5. Unzip the StardardItemFiles.zip and BidPriceFiles.zip files to the installed location of the 

CPSFE program (i.e. C:\Program Files\CPSFE).  Do this also after downloading updates. 

V. STARTING UP THE SYSTEM 

 

From within Start /Programs, double-click the CPSFE icon for the application.  Refer to Section 

VIII of this Manual for instructions on operating the System. 

 

VI. CONFIGURING THE SYSTEM 

 

The software package for the System has been designed to operate within the Windows 

environment.  The first time the CPS program is used, the System must be configured to properly 

run the system. 

 

CPSFE requires the Letter Gothic font for some of the reports.  If this font is not installed on 

your system, follow these steps to install the font (the font is supplied with CPSFE): 

 

1. From Start /Settings /Control Panel, select Fonts. 

2. In the Files /Install New Fonts screen, click on the Add button. 

3. In the Install New Fonts screen, select the directory that was just created by the Install 

process and select all three Letter Gothic fonts that appear in the Fonts list.  Check the 

box to copy the fonts to the Windows Directory.  Click the ok button to install the fonts 

and return to the Fonts screen. 

4. In the Fonts screen, click the Close button to exit back to the Control Panel. 

If you do not install the Letter Gothic font, your reports will not print properly. 

 

Follow the procedure outlined in Section V to start up the System and arrive at the Main Menu. 
 

Under the File menu select and import the Standard Item and Bid Price databases from the 

supplied zipped files before entering data for any projects. 

 

VII. CONVERTING DATA FILES 

 

Data files created for projects by DOS versions of the CPS program will not run in CPSFE 

Program Version 1.2.  The new version of the program requires that the data be converted.  

From the menu select File, then select Import Existing Project from, click on Old System. 
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VIII. OPERATING THE SYSTEM 

 

For ease of operation, the System has been designed to be point and click with drop down list 

driven.  Directions are provided on each menu for proceeding through the system with an online 

Help file.  Once into the System, various projects both English and Metric can be worked on in 

the same session, however, mixing of the Specification years on a given project is not allowed. 

 
A. Keyboard Navigation 

B. Troubleshooting 

C. File Menu 

D. Data Menu 

E. Reports Menu 

F. Goodies Menu 

G. Help Menu 

 

A. Keyboard Navigation 
 

If you prefer to use the keyboard instead of the mouse to 

navigate around CPSFE, here are the various keys that 

can be used.  These are standard for most Windows 

programs. 
 

Menus 

 

A pulldown menu can be selected from the menu bar by 

pressing the Alt key and, while holding it down, pressing 

the key corresponding to the underlined letter in the menu 

name.  For example, to pull down the File menu, press Alt-

F; to pull down the Data menu press Alt-D. 

 

To select an item from a pulldown menu, just press the key corresponding to the underlined letter in 

the name.  For example, to select Detail Estimate File from the Data menu, pulldown the Data menu 

and just press the d (or D) key. 

 

The left and right arrow keys can be used to cycle through the pulldown menus in the menu bar.  

The up and down arrow keys can be used to scroll up and down a pulldown menu. 

 

The Enter key can be used to select a highlighted option in a pulldown menu. 

 
Input Screens 

 

The four arrow keys allow you to move from field to field on an input screen.  The right and down 

keys will move you forward to the next field while the left and up keys will move you back to the 

previous field. 

 
Exceptions: 
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1. When on a pulldown control, the up and down keys move you through the selections for that 

pulldown.  Press enter to select a highlighted option in the pulldown control. 

2. When on a type-in control, the left and right keys move you back and forth through the text in 

that field. 

3. When in a radio button group, the left, right, up and down keys will cycle through the buttons, 

highlighting each button title.  Press enter to select a highlighted button. 

The Tab key will move you forward to the next field. 

 

The Enter key will also move you forward to the next field, except when you are on a pulldown field 

or a radio button group. 

 
Help 

 

Help can be invoked at any time by pressing the F1 key. 

 

B. Troubleshooting 
 
A DP Number is not selectable in the Open Project Screen Pulldown: 

 

If a DP Number is visible in the pulldown list but is dimmed (not selectable), it means 

that another copy of CPSFE is already running and using that particular project. 

 

CPSFE was designed to allow running multiple copies, as long as each copy of 

CPSFE is working with a different project.  No single project can be accessed by two running copies 

of CPSFE. 

 

If you are not running another copy of CPSFE, then at some previous session, CPSFE terminated 

abnormally while using this project and now the system thinks this project is in use.  In this case, 

select the Reset Button on the Open Project screen, and then select OK on the Warning screen.  

This will reset the in use flag for all projects.  You can then select the project from the pulldown on 

the Open Project screen. 

 
Error Messages: 

 
'Insufficient Memory' 

 

If you see this message, it means Windows is running low on Resources.  You can get this 

message even though you have a lot of memory installed on your computer, due to the poor memory 

management built into Windows and DOS.  Usually this is caused by having several other 

applications open while running CPSFE.  Select Cancel from the dialog (which will terminate CPSFE) 

and close any other applications. 

 

To avoid this problem, do not have any large applications open when running CPSFE.  This is a good 

idea when running any large applications in Windows. 

 

To begin, follow the procedure for starting up the System and arriving at the Main Menu.  From this 

Main Menu various operations can be performed. 

 

As shown next on the print of the Main Menu, there are five- (5) different main drop down menus for 

the system project. 
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C. FILE MENU 
 

1. Open Project 

2. Close Project 

3. New Project 

4. Change Project DP No 

5. Delete Project 

6. Import Existing Project FROM CPSFE NJDOT OPTION ONLY 

7. Copy Project to Diskette 

8. Create Standard Item File NJDOT OPTION ONLY 

9. Import New Standard Item File 

10. Create Bid Price File NJDOT OPTION ONLY 

11. Import New Bid Price File 

12. BAMS CES Data  NJDOT OPTION ONLY 

13. Export Data (for Upload) NJDOT OPTION ONLY 

14. Re-Index Databases 

15. Exit 
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1. Open Project 

 

This menu option is used to select the project to open.  When selected, a screen will appear with a 

pulldown menu showing the projects that can be opened.  Only one project can be opened at a time.  If 

you want to open several projects at once, run multiple sessions of CPSFE, with one project open in 

each session. 

 

Any project can only be active in one CPSFE session.  If you run multiple CPSFE sessions, projects that 

have been opened in other sessions will be dimmed (not selectable) in the pulldown in the Open screen. 

 If a project DP number is dimmed in the pulldown and it is NOT being used in another CPSFE session, 

see Troubleshooting. 
 

 
 

2. Close Project 
 

This menu option works in conjunction with the Open menu option.  It is used to close a project so that 

another one can be opened via the Open menu. 

 

Note:  When the Exit menu option is selected, the currently open project is automatically closed 

before CPSFE shuts down. 
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3. New Project 
 

This menu option is used to add a new project to CPSFE.  When selected, 

a new subdirectory will be created under the application directory (where 

CPSFE resides) using the supplied DP number as the name.  The DP 

number will also be added to the pulldown list in the Open screen. 

 

Once you have created a new project, you must open it before you can start 

entering data. 

 

Use this option only if you are creating a new project from scratch.  If you are trying to add existing data 

to your system, use the Import option.  

 

Note:  If you currently have a project open, you must close it to use this option. 

 

4. Change Project DP No. 
 

This menu option allows you to change the DP number of an existing project in CPSFE. 

 

When selected, a screen will appear with a pulldown listing the current projects.  Select a project from 

the list, and then type in the new DP number in the box below.  Once the new DP number has been 

entered, the OK button will undim.  Select the OK button to change the DP number, or the Quit button to 

exit without changing. 

 

Note:  This option is only available when no projects are open.  When a project is open, this option is 

dimmed out in the menu. 

 

5. Delete Project 
 

This menu option will remove a project from CPSFE.  When selected, a screen will appear with a 

pulldown listing the current projects.  Select a project from the list and click the OK button to remove the 

project. 

 

Warning.....This option will remove all data associated with the selected project, including its 

subdirectory.  If you want to save your project data, do so before using this option. 

 

Note:  If you currently have a project open, you must close it to use this option. 

 

If the DP number in the pulldown is dimmed, it means the project is currently open in another 

session.  If it is NOT open in another session, see Troubleshooting. 

 

6. Import Existing Project 
 

This menu option will import into CPSFE, a project submitted by a consultant (either from the old DOS 

based system, or from CPSFE).  The option to import a project created from the current system (CPSFE) 

is restricted to NJDOT personnel.  The option to import a project from the old DOS based system is open 

to anyone using this system, so that a project that was in progress under the old system can be 

completed using the new system. 

 

To import a project, select this option from the File menu.  Then select the system that created the files, 

either the old system or the current system (CPSFE).  When the Open screen appears, select the drive and 
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directory to import.  Next, double click on any database listed in the selected directory ( or single click on a 

database and click the Import button).  The entire directory will be copied and installed in the CPSFE 

system.  The project can then be opened via the Open Project in the File menu. 

 
7. Copy Project to Diskette 

 

Use this option to send project data to the NJDOT. 

 

When selected, a screen will appear with two pulldowns.  Select the project DP 

number from the first pulldown and the diskette drive letter from the second 

pulldown.  Click the OK button to copy the project or the Quit button to exit 

without copying the project. 

 

If the OK button is selected, the entire subdirectory for the selected project will be copied to the target 

drive. 

 

8. Create Standard Item File 
 

This menu option is for use by NJDOT personnel.  It will create a new Standard Item database from data 

downloaded from the mainframe. 

 

Start up CPSFE and select Create New Standard Item File from the File menu.  When the file selection 

screen appears, select the file that was downloaded from the mainframe and click the OK button.  The 

new database and associated index will be created in the application directory (where CPSFE resides), 

replacing the current Standard Item database.  The new Standard Item database and index (see below) 

can then be distributed on diskette to anyone using CPSFE. 

 Standitm.dbf - Standard Item database 

 Standitm.cdx - Index for Standard Item database 
 

If you are trying to import a Standard Item File supplied by the NJDOT, see the menu option Import New 

Standard Item File to replace the existing Standard Item file with a new one. 

 

9. Import New Standard Item File 
 

When a new Standard Item database becomes available on the NJDOT Web Site, use this option to 

replace the Standard Item database currently in your CPSFE system. 

 

After downloading the new file to a Temp directory, start up CPSFE.  From the File menu, select Import 

New Standard Item File.  When the file selection screen appears, select the new file from the Temp 

directory and click the Import button.  The new file and associated index will be imported into the system, 

replacing the old file. 

 

Note:  The old file and index will be saved as standitm.old and standitm.ocx just in case there is a 

problem with the new file.  It is suggested that you back up your CPSFE system before importing the 

new file. 
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10. Create Bid Price File 
 

This menu option is for use by NJDOT personnel.  It will maintain the Bid Price 

database with data downloaded from the mainframe.  On the mainframe, Bid Price 

files are created for an individual spec year.  The following menu options will allow you 

to update the Bid Price database as needed for different spec years. 

 

Start up CPSFE and select Create Bid Price File from the File menu.  To add data 

for a spec year, select Add Spec Year to File from the menu.  When the file 

selection screen appears, select the file that was downloaded from the mainframe 

and click the OK button.  If the data is for a spec year that is not already in the 

database, the data will be added to the database.  If the data is for a spec year that 

already exists in the database, a message window will appear stating that the spec year already exists 

and must be deleted before new data for that spec year can be added.  Select Delete Spec Year from 

File to remove the spec year from the Bid Price database. 

 

A third menu option, Initialize File, should only be used when you want to remove ALL data from the Bid 

Price database. 

 

The database and associated index will reside in the application directory (where CPSFE resides).  The Bid 

Price database and index (see below) can then be distributed on diskette to anyone using CPSFE. 

 

 Bidprice.dbf - Bid Price database 

 Bidprice.cdx - Index for Bid Price database 

If you are trying to import a Bid Price File supplied by the NJDOT, see the menu option Import New Bid 

Price File to replace the existing Bid Price file with a new one. 

 

11. Import New Bid Price File 
 

When a new Bid Price database becomes available on the NJDOT Web Site, use this option to replace 

the Bid Price database currently in your CPSFE system. 

 

After downloading the new file to a Temp directory, start up CPSFE.  From the File menu, select Import 

New Bid Price File.  When the file selection screen appears, select the new file from the Temp directory 

and click the Import button.  The new file and associated index will be imported into the system, replacing 

the old file. 

 

Note:  The old file and index will be saved as bidprice.old and bidprice.ocx just in case there is a problem 

with the new file.  It is suggested that you back up your CPSFE system before importing the new file. 

 

12. BAMS CES Data 
 

This menu option is for use by NJDOT personnel.  To use this option, select Open from the File menu 

and Open the Project to be exported or imported.  Then select BAMS CES Data from the File menu. 

 

The BAMS CES Data menu options will Export CPSFE Item Quantity data into the BAMS CES format 

or Import Item Unit Prices from the BAMS CES file into CPSFE. 

 

To Export data, select Export from the BAMS CES Data menu.   A Dialog selection will appear which 

will allow you to determine the Drive/Subdirectory the exported data will be written to. To Export, select 

CPSFE
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the Save button.  Only the Path from your selection will be used to determine where to write the data. 

The program will assign the filename based on the current DP Number. The default name will be 

NNNNN.DAT where NNNNN is the current Project DP Number. 

 
Import 

 

To Import data, select Import from the BAMS CES Data menu. A Dialog selection will appear which will 

allow you to determine the Drive/Subdirectory the data will be imported from. To Import, select the 

Import button.  Only the Path from your selection will be used to determine where to read the data. The 

program will determine the filename based on the current DP Number. The default name will be 

NNNNN.DAT where NNNNN is the current project DP Number. 

 
Notes: 

The filename and data both contain the DP Number of the Project being imported.  The program will 

check to make sure that the current open Project DP Number, the filename and the imbedded Project 

DP Number in the data all match. If there isn't a match an error message will be displayed. 

 

In addition to the previous check, the program determines the number of Item/Category records in the 

Import file and checks that the Quantity database contains the same number of records. If there isn't a 

match an error message will be displayed. 

 

The program checks to make sure that every Item Number in the Import file exists in the Quantity 

database. If there isn't a match, an error message will be displayed. 

 

The program expects that all records for a single Item Number will have the same Unit Price.  Therefore, 

the first occurrence of an Item in the Import file will determine price in the Quantity database for all 

records with that given Item Number. 

 

13. Export Data (for Upload) 
 

This menu option will create the ASCII text data files that are processed on the mainframe at the 

NJDOT.  To use this option, first Open the project to be converted and then select Export.  The files will 

be created in the subdirectory of the currently open project.  These converted files can then be uploaded 

to the mainframe. 

 

This option is for use by NJDOT Personnel only.  If you are sending files to the Dept. of 

Transportation, use the Copy Project to Diskette menu option. 

 

Database ASCII File Description 

Enghead.dbf DCxxxxx.hdr Engineer's Heading File 

Detail.dbf DCxxxxx.dtl Detail Estimate File 

Quantity.dbf DCxxxxx.qty Item Quantity File 

 

Note:   xxxxx is the DP number for the project being converted. 

14. Re-index Databases 
 

Database files may be viewed in different orders based on fields in the database.  Index files associated 

with a database are created for that purpose. These index files on occasion can become corrupted. 

When this happens, data that is in the database may appear to be missing, but in reality it is there. The 
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purpose of the Re-Index option is to re-index, or what is commonly called sort the database, to recreate 

the index file so that it matches the database. 

 

To Re-Index the CPSFE databases, select File from the CPSFE Main Menu and choose the option Re-

Index Databases. The Sort Data screen will appear where the sorting may be done. 

 

At the top of the screen is a box with radio buttons for selecting the type of sort you want, All or 

Individual. To the right are the Quit and OK Buttons. The rest of the screen is filled with Check Boxes 

for a database or group of related databases.  When the screen first appears, the selection box and Quit 

Button will be enabled and the rest will be disabled. 

 
Selecting Databases to Re-Index 

 

At the top of the Sort screen is a box that is used to select All Data or Individual Data. 

 

When the Radio Button for All Data is clicked on, all of the check boxes for the databases will be 

enabled and marked for you. If you want to sort all the data then click on the OK Button. However, if you 

want some, but not all, you can click again on the check boxes for the databases that you do not want to 

sort, and the check box will be unmarked. Then only the databases associated with the marked check 

boxes will be sorted when you click on the OK Button. 

 

When the Radio Button for Individual Data is clicked on, all of the check boxes will be enabled and left 

unmarked. At that point, click on the check box for the database(s) that you want sorted and then click 

on the OK Button. 

 
Push Buttons  

 

The OK Button will execute the indexing for the selected databases. 

 

The Quit Button will exit the sort screen. 

 

Note: The system automatically updates index files when records are added, updated or deleted. 

Theoretically, this option should never have to be run. However, if you are experiencing unpredictable 

results such as missing records that you know were entered or duplicate data, you may have a corrupted 

index. This would be the time to Re-Index. 

 

15. Exit 
 

This menu option shuts down the CPSFE system and closes any open databases for the current project. 

 This is the only safe way to exit CPSFE; using any other method to exit CPSFE may cause problems the 

next time CPSFE is started. 
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D. Data Menu 
 

1. Engineer‟s Heading 

2. Detail Estimate 

3. Item Quantity 

 

1. Engineer's Heading File 
 

Allows a Project's descriptive data to be added or modified.  Since there is such a small amount of data 

(comprising only one record in the database), there is no separate update screen.  There is also no 

delete facility, since this data record is required for the project. 

 
 

From the Data Menu, select E, “Engineer‟s Heading File” 
 

Required Fields 

Region - Current regions are North, Central, South & Headquarters 

Spec Year - Determines which standard items are available 

Project Description - At least one description line is required 

County - At least one county is required 

Preparer - Person preparing this project 

Date - Date of preparation 

 

Additional Fields: 

Federal Project Number 

Route 

Section 

Local Name 
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Select the OK button to add/update or the Quit button to exit without saving. 

Note: Data must be entered into this screen before you can begin entering Category or Item   data.  

Once this data has been entered, the Detail Estimate File menu option will undim. 

 

Federal 

Project 

Number: 

Insert the alphanumeric Federal Project Number that appears on the construction plans 

(construction number).  If the project does not have Federal funds, leave this field blank. 

Route & 

Section: 

Insert the alphanumeric Route and Section from the construction plans. 

Region: Select from the drop list the construction region where the project is located.  If there are 

dual regions, use the region number where the majority of the work occurs.  This is a 

required field. 

Local Name: Insert the alphanumeric local identifying name for the road.  If there is no Route and 

Section.  This is a required field when no route and section is available. 

Project 

Description: 

Insert the alphanumeric project description exactly as it appears on the construction plans 

and in the Special Provisions including municipality, county and Federal Project Number.  

The first line of the description is a required field. 

County: Select the county where the project is located.  A maximum of three counties can be 

indicated with the first county being where the majority of the work is located.  The first 

county is a required field and cannot be Statewide. 

 

HINT !  If the project is statewide, use “STATEWIDE” as the second county. 

 

Preparer: Insert the name of the person preparing of the Engineer's Estimate.  This is a required 

field. 

Date: Insert a valid date when this file is being prepared.  The format is MMDDYY.  This is a 

required field. 

 

After the data has been input, select the OK button to add/ update or the QUIT button to exit without 

saving. 

 

2. Detail Estimate Category File 
 

Allows new Category records to be added or existing records to be modified or deleted.  Category data 

may also be viewed online and printed. 

 

From the Data Entry Menu, select option #D, “Detail Estimate File”. 

 

The Detail Estimate File menu will appear, as shown below. 
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A. Adding Category Records 
 

To add new Category records, select Detail Estimate from the Data menu, then select Add Category. 

 

When the input screen appears, the only active fields will be Category Code, Last Item Number and 

the Quit button.  Enter a category code and a  last Item number and press enter to make the rest of the 

fields active.  (Until these two required fields are input, no other data is allowed).  After filling in the 

necessary fields, click the OK button to add the record to the database, or click Quit to exit the screen 

without adding the record. 

 
Category Code Must be unique for each record entered. 

Last Item Number Refers to the highest item in the Quantity file that is to be included in this category.  

This is a required field. 

Date Submitted The date this data is being entered.  This is a required field. 

Category 

Description 
Insert the main category description.  This will appear on the Engineer‟s Estimate 

as the total of all sub-categories.  For roadway items use ROAD and for bridge 

items use BRIDGE. This is a required field. 

 

Sub Descriptions Insert the description of the sub-category.  For a simple project, use ROADWAY 
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1 - 4 ITEMS or BRIDGE ITEMS.  For a project with Federal funding breakouts, the 

descriptions should be ROADWAY ITEMS, EROSION CONTROL ITEMS, UTILITY 

ITEMS, LANDSCAPE ITEMS, CONSTRUCTION ENGINEERING ITEMS, etc.  Use 

only one description per record.  Four lines are available for the description on each 

record, the first line of the description is a required field. 

Funding Information: 

Fund Code Numeric code identifying a group of funding data.  If a previously existing funding 

code is entered, the existing funding data associated with that code would be 

displayed.  Type in a funding code and press enter to undim the funding information 

fields. 

Participation  Either Participating or Non participating. 

C.E. Factor The next field is for the construction engineering factor.  For all projects, leave this 

field blank. 

Funding 

Factor 
Percentage of funding from this participant.  Total of both funding factors must 

equal 100%. 

Federal / State Who is participating; Federal or State.  If both federal and state are participating, 

always code State on funding #1 and Federal on funding #2. 

Type of Funds Insert the type of funds for the category.  For all „road‟ items except construction 

engineering and non-participating items, use RAW COST ROADWAY.  For 

construction engineering items, use CONSTRUCTION ENGINEERING.  For non-

participating items, use NON- PARTICIPATING.  For all „bridge‟ items, use RAW 

COST BRIDGE. 

 

Note:  Do not enter any funding #2 data if: 

 

Participation = N 

Funding factor #1 = 100% 

Federal/State #1 = F 

 

If you use an existing fund code, the funding information associated with that code would be 

displayed.  If you alter any of the funding information for an existing code, those changes will 

affect all categories using that funding code. 

 

Select the OK button to add or the Quit button to exit without adding. 

 

Note:  Data for at least one Category must be entered into this screen before you can begin entering 

Item data.  Once this data has been entered, the Item Quantity File menu option will undim. 

 

To create the category file, select option #A, Add Detail Estimate Record. 

 

The Detail Estimate Category File Add input panel will appear.  Enter the category number to add 

or create.  To initially create the file, enter number 1. 
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B. Editing Category Records 
 

To edit existing Category records, select Detail Estimate from the Data menu, then select Update 

Category.  When the update screen appears, select the Category to update from the pulldown.  Once a 

Category is selected, the associated data will be displayed on the screen.  Select the OK button to 

update or the Quit button to exit without updating. 

 

Note:  If funding information is changed, any category records with the same funding code will also be 

updated with the new funding data.  To make changes to the funding information highlight the 

funding code and press enter; the rest of the fields will become active. 
 

C. Deleting Category Records 
 

To delete existing Category records, select Detail Estimate from the Data menu, then select Delete 

Category.  When the delete screen appears, select the Category to delete from the pulldown.  Once a 

Category is selected, the description will be displayed on the screen.  Select the OK button to delete or 

the Quit button to exit without deleting. 
 

Note:  If the category is assigned to any Quantity Item records, it cannot be deleted. 
 

D. Viewing Category Records 
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To view existing Category records, select Detail Estimate from the Data menu, then select List 

Categories.  The list screen will show Category Code, Last Item and Description for each Category.  

There is an option to print the data while it is being viewed.  The printed report will show all data 

associated with each category. 

 

3. Item Quantity File 

 

Allows new Item records to be added or existing records to be modified or deleted.  Item data may also 

be viewed online and printed. 

 

A. Add Item Records 

B. Update Item Records 

C. Update Unit Prices/Quantities 

D. Delete Item 

E. List Items 

F. Insert Range of Items 

G. Delete Range of Items 

H. Flag High Alternates 
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A. Add Item Records 
 

To add new Item records, select Quantity from the Data menu, then select Add Item Records.  

 

To create the Quantity File, select option A, Add Records. 

 

The Quantity File Add input panel will appear as shown below. 

 

 
 
Item Number Enter the Pay Item Number from the Estimate of Quantities sheet of the construction 

plans.  If the number is less than four digits, leading zeros will automatically be 

added.  Note that the number entered cannot exceed the Last Item Number 

associated with the selected category. 

Category Code Select an existing Category from the pulldown list for this item. 

Standard Item If the item is a standard item, enter the Standard Item number.  If the number exists 

on the standard item file, the Description and Unit fields will automatically be filled 

in with the corresponding fields from the standard item file. 

Unit If this is a non-standard item, enter the item unit. 

Description If this is a non-standard item, enter the item description. 
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Quantity Enter the quantity to be associated with this item/category.  Note that all the 

quantities for an item must add up to a whole number. 

Unit Price Enter the unit price to be associated with this item. 

Alt. Item Code If this item will be an alternate item, enter the alternate code to be associated with 

this item. 

Road/Bridge Select the button that is appropriate for this item. 

Not In Proposal Check this box if this item/category is not to be carried forward to the Proposal file 

during processing on the mainframe. 

Carry Unit Price Check this box if the item Unit Price is to be preserved during bidding.  (The 

contractors cannot bid a unit price on this item). 

 
Browse Bid Prices button: 

 

Each time you enter or change the standard item field on the screen, the Bid Price database is 

searched for a matching standard item number.  If a match is found, the Browse Bid Prices button 

will become active.  If you select the button, a scroll list will appear containing all Bid Price records 

that match the standard item number.  You can select a unit price from that list by double clicking on 

a record (or highlighting the record and pressing enter).  The scroll list will disappear and the unit 

price from the selected record will appear in the Unit Price filed on the input screen. 

 

Select the OK button to add or the Quit button to exit without adding. 

 

Note:  If records already exist for an Item that you are adding, you will not be able to enter data into the 

Standard Item, Unit, Description, Road/Bridge, Alt. Item Code or Carry fields, since these 

fields must be the same for all records with the same item number.  If you need to change these 

fields, use the Update Item option. 

 

If some of the records being entered are for alternate items, select Flag High Alternates after 

you are done entering items, to calculate high alternates and readjust the Project Total. 

 

B. Update Item Records 
 

It may be necessary to modify the Quantity File as the project moves along its stages.  These 

modifications may require updating an item, deleting an item or range of items, or inserting an item or 

range of items. 

 

Prior to modifying the Quantity File, select option L, List Items, to determine which items need 

modification or where the modifications need to be made. 
 

To update existing Item records, select Item Quantity File from the Data menu, then select Update 

Item.  A selection screen will appear.  On the screen, type in the item number to be updated, press enter 

and all Quantity records with that item number will appear in the list.  Double click on the record to be 

updated (or use the arrow keys to select the record and press enter) and the update screen will appear 

with the data for that record.  If the record contains a Standard Item number, the Unit and Description 

fields will be dimmed.  To change these fields, type in a new Standard Item number (the Unit and 

Description associated with the new Standard Item number will appear), or delete the Standard Item 

number and press enter (the Unit and Description fields will undim and be blank). 

 
Browse Bid Prices button 
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Each time you enter or change the standard item field on the screen, the Bid Price database is 

searched for a matching standard item number.  If a match is found, the Browse Bid Prices button 

will become active.  If you select the button, a scroll list will appear containing all Bid Price records 

that match the standard item number.  You can select a unit price from that list by double clicking on 

a record (or highlighting the record and pressing enter).  The scroll list will disappear and the unit 

price from the selected record will appear in the Unit Price filed on the input screen. 

 

Click the OK button to update the Item record.  After the record has been updated, you will be 

returned to the item record selection list.  At this point, you can select another record for the same 

item number, enter a new item number or click on the Quit button to exit the screen. 

 

Note: If you update the Standard Item, Unit, Description, Road/Bridge, Alt. Item Code or Carry 

fields for an item, all records with the same item number will also be updated, since these fields 

must be the same for all records for an item. 

 

If some of the records being updated are for alternate items, and you update either the Unit Price 

or Quantity fields, select Flag High Alternates Menu after you are done updating items, to 

calculate high alternates and readjust the Project Total. 

 

C. Update Unit Prices/Quantities 
 

Use this option when you need to update Unit Prices, Quantities and Category Codes only.  When 

selected, a browse window will appear, listing records from the quantity database in Item Number / 

Category order.  Each record will display the Item Number, Category Code, Unit Price, Quantity, 

Standard Item Number and Description.  Only the three fields on each record are editable.  Using this 

window, you can move up and down the columns, making changes for any number of records in the 

database, without leaving the window. 

 

When this option is selected, a new menu, Window, will appear in the menu bar.  If for any reason, the 

control window containing the Save and Quit buttons is not visible on the screen, this menu option will 

move the window to the center of the screen and make it visible.  Under normal circumstances, you will 

not need to use this menu option.  When the Save or Quit button is selected, the menu option will 

disappear from the menu bar. 

Use the Page Up and Page Down keys to scroll through the window and the arrow keys to move from 

column to column and row to row.  Whenever a Unit Price or Quantity is changed, the Project Total 

window will be updated. 

 
Category Codes If you type a single digit into a category field and press enter, it will automatically be 

zero filled on the left. (i.e. If you type a 2 and press enter, a 02 will appear in the 

field). 

Unit Prices If you type a new amount into the unit price field and press enter, the Project Total 

window will immediately show the new total for the project.  If you blank out the 

amount in a unit price field and press enter and the item is a standard item, the Bid 

Price database will be searched for records with a matching standard item number.  

If any are found, they will be displayed in a scroll list.  You can select a unit price from 

that list by double clicking on the record (or highlighting the record and pressing 

enter).  You will be returned to the browse window and the selected unit price will 

appear in the previously blanked unit price field.  The Project Total window will also 

show the new total for the project 
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Quantities If you type a new amount into the quantity field and press enter, the Project Total 

window will immediately show the new total for the project. 

 

Note:  If some of the records being updated are for alternate items, and you update either the Unit Price 

or Quantity fields, select Flag High Alternates after you are done updating items, to calculate 

high alternates and readjust the Project Total. 

 

Click the Save button to save the changes back to the database, or click the Quit button to Quit without 

saving the changes.  If Quit is selected, the Project Total window will show the total amount for the 

project prior to any changes made in the browse window. 

 

D. Delete Item Records 
 

To delete existing Item records, select Item Quantity File from the Data menu, then select Delete Item. 

 A selection screen will appear.  On the screen, type in the item number to be updated, press enter and 

all Quantity records with that item number will appear in the list.  Double click on the record to be deleted 

(or use the arrow keys to select a record and press enter) and a warning screen will appear.  Click the 

OK button to delete the record or click the Quit button to return to the selection screen without deleting 

the record. 

 

The Project Total will be adjusted when records are deleted. 

 

E. List Item Records 
 

To view existing Item records, select Item Quantity File from the Data menu, then select List Items.  

The list screen will show Item Number, Category, Description, Quantity and Road/Bridge for every 

record in the Quantity file.  There is an option to print the data while it is being viewed.  The printed report 

will show all data associated with each record. 

 

There is a Find button to allow you to restrict the contents of the list to all records for a specific Item 

Number or Category.  To do this, make a selection from either the item number pulldown or the 

category pulldown, then click the Find button.  The list will then show all records matching the selection.  

If the Print button is selected after a Find, the report will also be restricted to those records. 

 

F. Insert a Range of Items 

 

To insert a range of items, enter the item number that the range is to be inserted after and the number of 

items to insert.  This feature does not physically create the records in the Quantity file, but renumbers the 

items following the specified insert after item to reflect the number of items to be inserted. 

 

Example:  If you enter item 45 and a range of 5 items, all items after item 45, will have their item 

numbers increased by 5 (item 46 will become 51, item 47 will become 52, etc). 
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G. Delete a Range of Items 
 

To delete a range of items, enter the item number that the deletion is to begin after and the number of 

items to delete.  This feature physically deletes the records in the Quantity file, and renumbers the items 

following the deleted range. 

 

Example:  If you enter item 45 and a range of 5 items, the first 5 items after item 45 will be deleted and 

all following items will have their item numbers decreased by 5. 

 

If the item sequence was:  45,46,47,48,49,50,51,52.... 

Items 46 through 50 will be deleted and item 51 will be renumbered as 46, item 52 will be 

renumbered as 47 and so on until the end of the file is reached. 

 

If there is a gap between item numbers, it will be ignored.  If the item sequence was: 

45,50,51,52,53,54,55,56... 

Items 50 through 54 will be deleted and item 55 will be renumbered as 46, item 56 will be 

renumbered as 47 and so on until the end of the file is reached. 

 

H. Flag High Alternates 

 

This menu option calculates and flags High Alternates and then recalculates the Project Total and 

updates the Project Total Window in the lower right corner of the screen. 

 

Any time the Project Total is calculated, any items flagged as High Alternates or items that are marked 

as "Should this Item Not be in the Proposal" are excluded from the total shown in the window. 

 

The Project Total is updated while Quantity data is being entered or updated, however, changes to or 

adding Items that are marked as alternates can change which items will be considered High Alternates, 

which will change the Project Total.  The system has no way of knowing when you are finished adding to 

or updating alternate items, so it continues to update the Project Total based on how alternates were 

previously flagged (or not flagged)..  Use this option after you have entered or made changes to 

alternate items, to readjust the Project Total. 

 

Note: The menu option to produce the Engineer's Estimate Report also calculates and flags High 

Alternates. 

High Alternates are also calculated each time a Project is opened (right before the Project Total 

window appears). 

 

E. REPORT MENU 
 

Once the data files have been created for a particular project, various Reports can be printed.  A 

Reports option has been provided on the Main Menu which can be used to produce the 

Preliminary Engineer's Estimate (the Final is done on the CPS Mainframe program) or a printed 

copy of the various data files for the user's own use. 

 

From the Main Menu, select option #R, Reports. 

 

The Reports Menu will appear, a print of which is shown at the top of Page 30.  As shown on this 

menu, there are four (4) types of reports available.  These reports are as follows: 
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1. Engineer's Heading 

2. Produce Engineer's Estimate 

3. Standard Item File 

4. Bid Price File 

 

NOTE: Four printed copies of the “Preliminary” (becomes Final in the CPS Main program) Engineer‟s 

Estimate as generated form this program and a copy of the data file on 3 ½” disk shall be 

included in the Final Submission.  For subsequent revisions, submit two printed copies and the 

revised data file on disk. 
 

1. Engineer's Heading Report 
 

This option prints the data entered into the Engineer's Heading file.  An example of this type of report is 

shown in the appendix 

 

2. Engineer’s Estimate Report 
 
This option produces and prints the “Preliminary” Engineer's Estimate.  It also performs edit checks on 

the data.  A report will not be produced until all data passes the checks. 

 

Items that are flagged as High Alternates and items that are marked as "Should this Item Not be in 

the Proposal" will NOT be included in the total. 

 

An example of this report is shown in the appendix. 

 

3. Standard Item File Listing 
 

This option lists and prints the Standard Item file. 

 

When selected, a screen will appear with an empty scroll list.  To generate a list, select a Spec. Year 

from the pulldown and select one of the radio buttons, All Items or Select.  If you choose Select, you 

must supply the first two characters of the Standard Item number.  After making the above selections, 

click on the List button to generate the list.  When the records appear in the scroll list, the Print button 

will become active.  Click on the Print button to send the list to the printer. 

 

4. Bid Price File Listing 

 

This option lists the Bid Price file. 

 

When selected, a screen will appear with all Bid Price records in a scroll list. Since the file is quite large, 

it will take a few seconds for the list to appear.   

 

F. Goodies Menu 
 

1. Clock 

2. Calculator 

3. Change Background 
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1. Clock 

 

Selecting Clock from the Goodies menu will place a digital clock on the upper right portion of the 

screen, just below the menu bar.  To remove the clock, reselect it from the Goodies menu. 

 
2. Calculator 

 

The Calculator is a Microsoft® applet included in CPSFE.  It works like any standard handheld 

calculator. 

 
3. Change Background 

 

This option will allow you to select any .bmp (bit map) file to be used as the desktop background.  When 

selected, a standard file selection dialog will appear, from which .bmp files can be selected.  In general, 

any file that can be used as wallpaper in windows can be used as a background in CPSFE.  The 

selection will be saved for subsequent CPSFE sessions. 

 

G. Help Menu 
 

1. Contents 
 

The Contents menu is the main Help menu.  From there you can follow various options to the help topic 

for a particular menu item.  This is a standard windows help screen including Search, Back and History 

buttons. 

 

2. Search 
 

The Search option allows you search the help database by keyword and topic.  This is a standard 

windows help screen and works in the same manner as any windows help search. 

 

3. About CPSFE 

 

This screen provides the current version number of CPSFE and some information about your computer's 

environment, such as Available Memory, Hard Drive Size and the Current Directory. 
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IX. STANDARD PAY UNIT ABBREVIATIONS 

 

The following is a list of the standard pay unit abbreviations recognized by this system.  The use 

of these abbreviations will produce the accompanying descriptions to appear on the proposals.  If 

there are pay units that do not appear on the list, create an abbreviation that has a maximum of 

three letters.  It must be remembered, however, that only these three letters will appear on the 

proposal as the pay unit instead of the desired full description. 

 
Pay Unit Description Abbreviation 

Acre   . . . . . . . . . . . . . . . . . . . . . . . .  A 

Bale   . . . . . . . . . . . . . . . . . . . . . . . .  BA 

Barrel   . . . . . . . . . . . . . . . . . . . . . . .  BBL 

Board Feet   . . . . . . . . . . . . . . . . . . . BF 

Bundle   . . . . . . . . . . . . . . . . . . . . . .  BU 

Crew Hour   . . . . . . . . . . . . . . . . . . .  CH 

Cubic Foot   . . . . . . . . . . . . . . . . . . .  CF 

Cubic Meter   . . . . . . . . . . . . . . . . . .  CM 

Cubic Yard   . . . . . . . . . . . . . . . . . . .  CY 

Day   . . . . . . . . . . . . . . . . . . . . . . . . . DAY 

Each   . . . . . . . . . . . . . . . . . . . . . . . . EA 

Gallon   . . . . . . . . . . . . . . . . . . . . . . . GAL 

Hectare   . . . . . . . . . . . . . . . . . . . . . . HA 

Hour   . . . . . . . . . . . . . . . . . . . . . . . .  HRS 

Kilogram   . . . . . . . . . . . . . . . . . . . . . KG 

Linear Foot   . . . . . . . . . . . . . . . . . . . LF 

Linear Meter   . . . . . . . . . . . . . . . . . . LM 

Liter   . . . . . . . . . . . . . . . . . . . . . . . .  L 

Lump Sum   . . . . . . . . . . . . . . . . . . .  LS 

Man-Day   . . . . . . . . . . . . . . . . . . . . . MD 

Man-Hour   . . . . . . . . . . . . . . . . . . . .  MH 

Mega Board Measure . . . . . . . . . . . MBM 

Megagram   . . . . . . . . . . . . . . . . . . . . MGR 

Mega Gallon. . . . . . . . . . . . . . . . . . .   MG 

Month   . . . . . . . . . . . . . . . . . . . . . . .  MO 

Pair   . . . . . . . . . . . . . . . . . . . . . . . . .  PR 

Pound   . . . . . . . . . . . . . . . . . . . . . . . LBS 

Rod   . . . . . . . . . . . . . . . . . . . . . . . . .  ROD 

Sample   . . . . . . . . . . . . . . . . . . . . . .  SMP 

Square Foot   . . . . . . . . . . . . . . . . . .  SF 

Square Meter   . . . . . . . . . . . . . . . . .  SM 

Square Yard   . . . . . . . . . . . . . . . . . .  SY 

Ton   . . . . . . . . . . . . . . . . . . . . . . . . .  T 

Trip   . . . . . . . . . . . . . . . . . . . . . . . . .  TRP 

Unit   . . . . . . . . . . . . . . . . . . . . . . . . .  U 

Unit Day   . . . . . . . . . . . . . . . . . . . . .  UD 
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Engineer’s Heading File Report 

 

 

DP Number  96002  Federal Project Number: BRM-8482(104)  Spec Year:1996 

 

Route:     Section:     Region: North 

 

Local Name:  

 

  MADISON AVENUE BRIDGE 

 

Project Description: 

 

MADISON AVENUE BRIDGE OVER HACKENSACK RIVER; 

BRIDGE REPLACEMENT AND ROADWAY WIDENING; 

BOROUGHS OF ORADELL AND NEW MILFORD, BERGEN COUNTY. 

FEDERAL PROJECT NO. BRM-8482(104). 

 

Counties: BERGEN  

 

Preparer: K. ZUMMO 

 

Date:  02/02/1998 
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Detail Estimate Category File Report 

 

DP Number: 96802   Route:     Section: 

Project: MADISON AVENUE BRIDGE OVER HACKENSACK RIVER; 

 BRIDGE REPLACEMENT AND ROADWAY WIDENING; 

 BOROUGHS OF ORADELL AND NEW MILFORD, BERGEN COUNTY. 

 FEDERAL PROJECT NO. BRM-8482(104). 

____________________________________________________________________________________________

_________ 

Category: 01  Last Item Number: 0077  Date Submitted: 2/2/98 

Cat. Desc: ROADWAY ITEMS         Fund Code: 01 

Sub 1 Desc: ROADWAY ITEMS        

 Part/Non:  P 

Sub 2 Desc:           C.E. Factor: 

Sub 3 Desc: 

Sub 4 Desc: 

Fund Fact: 100  Fed/State: F  Type Funds: ROADWAY ITEMS 

Fund Fact:  Fed/State:  Type Funds: 

____________________________________________________________________________________________

_________ 

Category: 02  Last Item Number: 0066  Date Submitted: 2/2/98 

Cat. Desc: ROADWAY ITEMS         Fund Code: 01 

Sub 1 Desc: EROSION CONTROL ITEMS       

 Part/Non:  P 

Sub 2 Desc:           C.E. Factor: 

Sub 3 Desc: 

Sub 4 Desc: 

Fund Fact: 100  Fed/State: F  Type Funds: ROADWAY ITEMS 

Fund Fact:  Fed/State:  Type Funds 

____________________________________________________________________________________________

_________ 

 

Category: 03  Last Item Number: 0070  Date Submitted: 2/2/98 

Cat. Desc: ROADWAY ITEMS         Fund Code: 01 

Sub 1 Desc: LANDSCAPE - GENERAL ITEMS       Part/Non:  P 

Sub 2 Desc:           C.E. Factor: 

Sub 3 Desc: 

Sub 4 Desc:      44 

Fund Fact: 100  Fed/State: F  Type Funds:  

Fund Fact:  Fed/State:  Type Funds: CONSTRUCTION ENGINEERING 
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Detail Estimate Category File Report 

 

DP Number: 96802   Route:     Section: 

Project: MADISON AVENUE BRIDGE OVER HACKENSACK RIVER; 

 BRIDGE REPLACEMENT AND ROADWAY WIDENING; 

 BOROUGHS OF ORADELL AND NEW MILFORD, BERGEN COLJNTY. 

 FEDERAL PROJECT NO. BRM-8482(104). 

____________________________________________________________________________________________

_________ 

Category: 05  Last Item Number: 0012  Date Submitted: 10/27/97 

Cat. Desc: ROADWAY ITEMS         Fund Code: 03 

Sub 1 Desc: NON-PARTICIPATING ITEMS       Part/Non:  N 

Sub 2 Desc:           C.E. Factor: 

Sub 3 Desc:  

Sub 4 Desc: 

Fund Fact: 100  Fed/State: F  Type Funds: NON-PARTICIPATING ITEMS 

Fund Fact:  Fed/State:  Type Funds: 

____________________________________________________________________________________________

_________ 

Category: 06  Last Item Number: 0102  Date Submitted: 11/7/97 

Cat. Desc: BRIDGE ITEMS         Fund Code: 04 

Sub 1 Desc: STRUCTURE # 0200-38C        Part/Non:  P 

Sub 2 Desc: MADISON AVENUE BRIDGE OVER HACKENSACK     C.E. 

Factor: 

Sub 3 Desc: STRUCTURE TYPE X081 

Sub 4 Desc: 

Fund Fact: 100  Fed/State: F  Type Funds: BRIDGE ITEMS 

Fund Fact:  Fed/State:  Type Funds: 

____________________________________________________________________________________________

_________ 
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Quantity File Report 

DP Number: 96802 Route:  MADISON AVE Section:  Region:  Headquarters Spec Year: 1996 

 

Project:  REPLACEMENT MADISON AVENUE BRIDGE, ORADELL, NEW MILFORD 

           Federal Project Number: 

 

 

 

 

Item 

No. 

 

Cat 

Cod

e 

 

S.I. 

No. 

 

 

Description 

 

 

Quantity 

 

 

Price 

 

 

Unit 

 

R/B 

Cod

e 

Alt 

Item 

Code 

 

 

Flag 

 

S.I. 

Carry 

Not 

Carr 

Prop 

 

0001 01 1C21E PERFORMANCE BOND AND 

PAYMENT BOND 

1.00 9000.0000 LS R 

0002 01 1D21C FINAL CLEANUP 1.00 4000.0000 LS R 

0003 01 1E21C CONSTRUCTION LAYOUT 1.00 20000.0000 LS R 

0004 04 1E41E FIELD OFFICE TYPE C SET-UP 1.00 20000.0000 U R 

0005 04 1E41F FIELD OFFICE TYPE C MAINTENANCE 18.00 1000.0000 MO R 

0006 04 1E31G TELEPHONE SERVICE 1.00 5000.0000 LS R 

0007 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0008 04 9Z99Z NO ITEM 0.00 0.0000 U R 

0009 04 9Z99Z NO ITEM 0.00 0.0000 U R 

0010 01 1G21C TRAINEES 1000.00 1.0000 HRS R 

0011 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0012 05 1G13I OWNER‟S AND CONTRACTOR‟S 

PROTECTIVE 

1.00 2500.0000 LS R 

0013 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0014 01 1H21D MOBILIZATION 1.00 76000.0000 LS R 

0015 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0016 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0017 01 2A21C CLEARING SITE 1.00 35000.0000 LS R 

0018 01 2B25B ROADWAY EXCAVATION, 

UNCLASSIFIED 

1026.00 128.0000 CM R 

0019 01 2C02A POROUS FILL 359.00 40.0000 CM R 

0020 01 2B50G SAWCUTTING 76.00 7.0000 LM R 

0021 01 2B80N MILLING, VARIABLE DEPTH 343.00 18.0000 SM R 

0022 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0023 01 2G02E EARTH EXCAVATION FOR TEST PITS 6.00 65.00 CM R 

0024 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0025 01 2H21C SUBBASE 157.00 40.0000 CM R 

0026 02 2L05A SILT FENCE 310.00 5.0000 LM R 

0027 02 2L22C INLET FILTERS 3.00 50.0000 U R 

0028 02 2L26C INLET PROTECTION, HAYBALE 

BARRIER 

1.00 50.0000 U R 

0029 02 2L20F CONSTRUCTION DRIVEWAY 173.00 15.0000 MGR R 

0030 02 2L03H HAYBALES 40.00 5.0000 U R 

0031 01 9Z99Z NO ITEM 0.00 0.0000 U R 
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Quantity File Report 

DP Number: 96802 Route:  MADISON AVE Section:  Region:  Headquarters Spec Year: 1996 

 

Project:  REPLACEMENT MADISON AVENUE BRIDGE, ORADELL, NEW MILFORD 

           Federal Project Number: 

 

 

 

 

Item 

No. 

 

Cat 

Cod

e 

 

S.I. 

No. 

 

 

Description 

 

 

Quantity 

 

 

Price 

 

 

Unit 

 

R/B 

Cod

e 

Alt 

Item 

Code 

 

 

Flag 

 

S.I. 

Carry 

Not 

Carr 

Prop 

 

0032 01 3A15D DENSE GRADED AGGREGATE BASE 

COURSE, 150 MM THICK 

735.00 7.0000 SM R 

0033 02 3B08E COARSE AGGREGATE, SIZE NO. 8 1.00 70.0000 CM R 

0034 01 3E02B BITUMINOUS-STABILZED BASE 

COURSE, MIX I-2 

134.00 55.0000 MGR R 

0035 01 4D14B BITUMINOUS CONCRETE SURFACE 

COURSE MIX I-4 HD 

132.00 60.0000 MGR R 

0036 01 4D31C PRIME COAT 860.00 0.2600 L R 

0037 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0038 01 6B35G 525 MM REINFORCED CONCRETE 

CULVERT PIPE 

6.00 140.0000 LM R 

0039 01 6C26C INLETS, TYPE B 1.00 1800.0000 U R 

0040 01 6C31E MANHOLES 1.00 2000.0000 U R 

0041 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0042 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0043 01 6C22I RESET CASTINGS 3.00 200.0000 U R 

0044 01 6E20G 225 BY 400 MM WHITE CONCRETE 

VERTICAL CURB 

57.00 60.0000 LM R 

0045 01 6G10C CONCRETE SIDEWALK, 100 MM 

THICK 

97.00 40.0000 SM R 

0046 01 6G20D CONCRETE SIDEWALK, 

REINFORCED, 200 MM THICK 

21.00 55.0000 SM R 

0047 01 6G15E BITUMINOUS CONCRETE DRIVEWAY, 

150 MM THICK 

53.00 35.0000 SM R 

0048 01 6G01R PUBLIC SIDEWALK CURB RAMP 

DELINEATION 

8.00 100.0000 SM R 

0049 01 6L21B BEAM GUIDE RAIL 46.00 75.0000 LM R 

0050 01 6L31B BEAM GUIDE RAIL, BRIDGE 21.00 230.0000 LM R 

0051 01 6L12C SLOTTED GUIDE RAIL TERMINALS 1.00 2400.0000 U R 

0052 01 6L15C EXTRUDER TERMINALS 1.00 4200.0000 U R 

0053 01 6L41C BEAM GUIDE RAIL ANCHORAGES 1.00 500.0000 U R 

0054 01 6N21M RESET FENCE 104.00 58.0000 LM R 

0055 01 6N24T TEMPORARY CHAIN-LINK FENCE, 2.4 

M HIGH 

150.00 72.0000 LM R 

0056 01 6P50I RIPRAP STONE SLOPE PROTECTION, 

750 MM THICK 

118.00 60.0000 SM R 

0057 01 6Q03B BARRICADES, TYPE IIIA 4.00 60.0000 LM R 

0058 01 6Q22B BREAKWAY BARRICADES 6.00 110.000 U R 

0059 01 6Q44C PRECAST CONCRETE CURB, 

CONSTRUCTION BARRIER, TYPE 4 

25.00 90.0000 LM R 

0060 01 6Q10F CONSTRUCTION SIGNS 34.00 175.0000 SM R 

0061 01 6R22D TRAFFIC MARKINGS, LINES, LONG 

LIFE, THERMOPLASTIC 

514.00 1.5000 LM R 
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Quantity File Report 

DP Number: 96802 Route:  MADISON AVE Section:  Region:  Headquarters Spec Year: 1996 

 

Project:  REPLACEMENT MADISON AVENUE BRIDGE, ORADELL, NEW MILFORD 

           Federal Project Number: 

 

 

 

Item 

No. 

 

Cat 

Cod

e 

 

S.I. 

No. 

 

 

Description 

 

 

Quantity 

 

 

Price 

 

 

Unit 

 

R/B 

Cod

e 

Alt 

Item 

Code 

 

 

Flag 

 

S.I. 

Carry 

Not 

Carr 

Prop 

 

0062 01 6s20b SIGNS 1.00 300.0000 SM R 

0063 01 6V01A RESET WATER VALVE BOXES 4.00 50.0000 U R 

0064 03 8F04C TOPSOILING, 100 MM THICK 695.00 4.0000 SM R 

0065 03 8H23C FERTILIZING AND SEEDING, TYPE A-3 695.00 1.0000 SM R 

0066 02 8H60C FERTILIZING AND SEEDING, TYPE F 77.00 1.0000 SM R 

0067 03 8K31C STRAW MULCHING 772.00 0.4500 SM R 

0068 03 8N05B NONVEGETATIVE SURFACE, 

BITUMINOUS CONCRETE 

88.00 28.0000 SM R 

0069 01 6Q21D DRUMS 10.00 25.0000 U R 

0070 03 9Z99Z NO ITEM 0.00 0.0000 U R 

0071 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0072 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0073 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0074 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0075 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0076 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0077 01 9Z99Z NO ITEM 0.00 0.0000 U R 

0078 06 2A31C CLEARING SITE, BRIDGE 1.00 80000.0000 LS B 

0079 06 2F12E FOUNDATION EXCAVATION 265.00 70.0000 CM B 

0080 06 2F21F COFFERDAMS 1.00 20000.0000 LS B 

0081 06 5A21A CONCRETE IN STRUCTURES, 

FOOTINGS 

150.00 260.0000 CM B 

0082 06 5A31A CONCRETE IN STRUCTURES, 

RETAINING WALLS 

90.00 550.0000 CM B 

0083 06 5A12B CONCRETE IN SUBSTRUCTURES, 

ABUTMENT WALLS 

125.00 450.0000 CM R 

0084 06 5A13C CONCRETE IN SUPERSTRUCTURE, 

DECK SLABS 

30.00 700.0000 CM B 

0085 06 5A23C CONCRETE IN SUPERSTRUCTURE, 

SIDEWALKS 

5.00 500.0000 CM B 

0086 06 5A33C CONCRETE IN SUPERSTRUCTURE, 

PARAPETS 

56.00 300.0000 LM B 

0087 06 5A21E REINFORCEMENT STEEL IN 

STRUCTURES 

9900.00 1.6000 KG B 

0088 06 5A31E REINFORCEMENT STEEL IN 

STRUCTURES, EPOXY COATED 

6500.00 2.0000 KG B 

0089 06 5A31G EPOXY WATERPROOFING  60.00 20.0000 SM B 

0090 06 5A30H 65 BY 65 MM PREFORMED 

ELASTOMERIC JOINT SEALER 

27.00 65.0000 LM B 

0091 06 5A21L SAWCUT GROOVED DECK SURFACE 150.00 15.0000 SM B 
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Quantity File Report 

 

DP Number: 96802 Route:  MADISON AVE Section:  Region:  Headquarters Spec Year: 1996 

 

Project:  REPLACEMENT MADISON AVENUE BRIDGE, ORADELL, NEW MILFORD 

           Federal Project Number: 

 

 

 

Item 

No. 

 

Cat 

Cod

e 

 

S.I. 

No. 

 

 

Description 

 

 

Quantity 

 

 

Price 

 

 

Unit 

 

R/B 

Cod

e 

Alt 

Item 

Code 

 

 

Flag 

 

S.I. 

Carry 

Not 

Carr 

Prop 

 

0092 06  PRECAST CONCRETE ORNAMENTAL 

CAPS 

4.00 1250.0000 U B 

0093 06  PRESTRESSED CONCRETE BOX 

BEAM, 1,220 BY 686 MM 

145.00 550.0000 LM B 

0094 06  PRESTRESSED CONCRETE 

CHANNEL BEAM, 1,220 BY 686 MM 

16.00 600.0000 LM B 

0095 06 5C19A STRUCTURAL STEEL 1.00 23760.0000 LS B 

0096 06 5C22D STRUCTURAL STEEL DECK JOINTS 1.00 5000.0000 LS B 

0097 06 5E19B TEST PILES 70.00 200.0000 LM B 

0098 06  STEEL PIPE PILES, 305MM DIAMETER 1170.00 95.0000 LM B 

0099 06 5E21M FURNISHING EQUIPMENT FOR 

DRIVING PILES 

1.00 42500.0000 LS B 

0100 06  METAL RAILING (STEEL) 60.00 200.0000 LM B 

0101 06  150 MM GAS SLEEVE 31.00 300.0000 LM B 

0102 06  TEMPORARY WATER MAIN 1.00 120000.0000 LS B 

0103 06 9Z99Z NO ITEM 0.00 0.0000 U B 
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Preliminary Engineer’s Estimate 

DP Number:  96802 Route:  Section:   Region:  North Spec Year: 1996 

 

 Project: MADISON AVENUE BRIDGE OVER HACKENSACK RIVER;  Current Bid 

Price File: 

BRIDGE REPLACEMENT AND ROADWAY WIDENING;    02/03/1998 

BOROUGHS OF ORADELL AND NEW MILFORD, BERGEN COUNTY. Federal Project 

Number: FEDERAL PROJECT NO. BRM-8482(104).          BRM-

8482(104) 

 

 

Item 

No. 

 

Cat 

Code 

 

S.I 

No.. 

 

 

Description 

 

 

Unit 

 

R/B 

Code 

Alt 

Item 

Code 

 

 

Quantity 

 

 

Price 

 

Extended 

Amounts 

Not 

Carry 

Prop 
 

 ROAD 

       ROADWAY ITEMS 

0001 01 1C21E PERFORMANCE BOND AND 

PAYMENT BOND 

LS R  1.00 9.000.0000 9,000.00  

0002 01 1D21C FINAL CLEANUP LS R  1.00 4.000.0000 4,000.00  

0003 01 1E21C CONSTRUCTION LAYOUT LS R  1.00 20.000.0000 20,000.00  

0009 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0010 01 1G21C T RAINEES HRS R  1,000.00 1.0000 1,000.00  

0011 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0013 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0014 01 1H21D MOBILIZATION LS R  1.00 77.000.0000 77,000.00  

0015 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0016 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0017 01 2A21C CLEARING SITE LS R  1.00 35.000.0000 35,000.00  

0018 01 2B25B ROADWAY EXCAVATION, 

UNCLASSIFIED 

CM R  1.026.00 18.0000 18,468.00  

0019 01 2C02A POROUS FILL CM R  359.00 40.0000 14,360.00  

0020 01 2B50G SAWCUTTING LM R  76.00 7.0000 532.00  

0021 01 2B80N MILLING, VARIABLE DEPTH SM R  343.00 18.0000 6,174.00  

0022 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0023 01 2G02E EARTH EXCAVATION FOR TEST 

PITS 

CM R  6.00 65.0000 390.00  

0024 01 9Z99Z NO TIEM U R  0.00 0.0000 0.00  

0025 01 2H21C SUBBASE CM R  157.00 40.0000 6,280.00  

0031 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0032 01 3A15D DENSE GRADED AGGREGATE 

BASE COURSE,  150 MM THICK 

SM R  735.00 7.0000 5,145.00  

0034 01 3E02B BITUMINOUS-STABILIZED BASE 

COURSE, MIX I-2 

MGR R  134.00 

 

55.0000 7,370.00  

0035 01 4D14B BITUMINOUS CONCRETE 

SURFACE COURSE , MIX I-4 HD 

MGR R  132.00 60.0000 7,920.00  

0036 01 4D31C PRIME COAT L R  860.00 0.2600 223.60  

0037 01 9Z99Z NO TIEM U R  0.00 0.0000 0.00  

0038 01 6B35G 525 MM REINFORCED CONCRETE 

CULVERT PIPE 

LM R  6.00 140.0000 840.00  

0039 01 6C26C INLETS, TYPE B U R  1.00 1,800.0000 1,800.00  

0040 01 6C31E MANHOLES U R  1.00 2,000.0000 2,000.00  

           

 

Note: Extended amounts marked with “*” and items Not Carry to Proposal are not included in totals 
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Preliminary Engineer’s Estimate 

DP Number:   96802 Route:  Section:  Region:  North  Spec Year: 1996 

 

 Project: MADISON AVENUE BRIDGE OVER HACKENSACK RIVER;  Current Bid 

Price File: 

BRIDGE REPLACEMENT AND ROADWAY WIDENING;    02/03/1998 

BOROUGHS OF ORADELL AND NEW MILFORD, BERGEN COUNTY.  Federal Project 

Number: FEDERAL PROJECT NO. BRM-8482(104).          BRM-

8482(104) 

 

 

 

Item 

No. 

 

Cat 

Code 

 

S.I 

No.. 

 

 

Description 

 

 

Unit 

 

R/B 

Code 

Alt 

Item 

Code 

 

 

Quantity 

 

 

Price 

 

Extended 

Amounts 

Not 

Carry 

Prop 
 

0041 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0042 01 9Z99Z NO ITEM U R  0.00 0.0000 0.00  

0043 01 6C22I RESET CASTINGS U R  3.00 200.0000 600.00  

0044 01 6E20G 225 BY 400 MM WHITE 

CONCRETE VERTICAL CURB 

LM R  57.00 60.0000 3,420.00  

0045 01 6G10C CONCRETE SIDEWALD, 100 MM 

THICK 

SM R  97.00 40.0000 3,880.00  

0046 01 6G20D CONCRETE SIDEWALD, 

REINFORCED, 200 MM THICK 

SM R  21.00 55.0000 1,155.00  

0047 01 6G15E BITUMINOUS CONCRETE 

DRIVEWAY,  150 MM THICK 

SM R  53.00 35.0000 1,855.00  

0048 01 6G01R PUBLIC SIDEWALD CURB RAMP 

DELINEATION 

SM R  8.00 100.0000 800.00  

0049 01 6L21B BEAM GUIDE RAIL LM R  46.00 75.0000 3,450.00  

0050 01 6L31B BEAM GUIDE RAIL, BRIDGE LM R  21.00 230.0000 4,830.00  

0051 01 6L12C SLOTTED GUIDE RAIL TERMINALS U R  1.00 2,400.0000 2,400.00  

0052 01 6L15C EXTRUDER TERMINALS U R  1.00 4,200.0000 4,200.00  

0053  01 6L41C BEAM GUIDE RAIL ANCHORAGES U R  1.00 500.0000 500.00  

0054 01 6N21M RESET FENCE LM R  104.00 58.0000 6,032.00  

0055 01 6N24T TEMPORARY CHAIN-LINK FENCE, 

2.4 M HIGH 

LM R  150.00 72.0000 10,800.00  

0056 01 6P50I RIPRAP STONE SLOPE 

PROTECTION, 750 MM THICK 

SM R  118.00 60.0000 7,080.00  

0057 01 6Q03B BARRICADES, TYPE IIIA LM R  4.00 60.0000 240.00  

0058 01 6Q22B BREAKWAY BARRICADES U R  6.00 110.0000 660.00  

0059 01 6Q44C PRECAST CONCRETE CURB, 

CONSTRUCTION BARRIER, TYPE 

4 

LM R  25.00 90.0000 2,250.00  

0060 01 6Q10F CONSTRUCTION SIGNS SM R  34.00 175.0000 5,950.00  

0061 01 6R22D TRAFFIC MARKINGS, LINES, 

LONG LIFE, THERMOPLASTIC 

LM R  514.00 1.5000 771.00  

0062 01 6S20B SIGNS SM R  1.00 300.0000 300.00  

0063 01 6V01A RESET WATER VALUE BOXES U R  4.00 50.0000 200.00  

0069 01 6Q21D DRUMS U R  10.00 25.0000 250.00  

0071 01 9Z99Z NO TIEM U R  0.00 0.0000 0.00  

0072 01 9Z99Z NO TIEM U R  0.00 0.0000 0.00  

0073 01 9Z99Z NO TIEM U R  0.00 0.0000 0.00  

0074 01 9Z99Z NO TIEM U R  0.00 0.0000 0.00  

 
Note: Extended amounts marked with “*” and items Not Carry to Proposal are not included in totals 



CONTRACTOR PAYMENT SYSTEM FRONT END 

 

 

  Page 39 

Pengest 02/04/1998  Contractor Payment System    Page  03 

Preliminary Engineer’s Estimate 

DP Number:   96802 Route:  Section:  Region:  North  Spec Year: 1996 

 

 Project: MADISON AVENUE BRIDGE OVER HACKENSACK RIVER;  Current Bid 

Price File: 

BRIDGE REPLACEMENT AND ROADWAY WIDENING;    02/03/1998 

BOROUGHS OF ORADELL AND NEW MILFORD, BERGEN COUNTY.  Federal Project 

Number: FEDERAL PROJECT NO. BRM-8482(104).          BRM-

8482(104) 

 

 

Item 

No. 

 

Cat 

Code 

 

S.I 

No.. 

 

 

Description 

 

 

Unit 

 

R/B 

Code 

Alt 

Item 

Code 

 

 

Quantity 

 

 

Price 

 

Extended 

Amounts 

Not 

Carry 

Prop 
 

0075 01 9Z99Z NO ITEM U R  0.00 0.0000   

0076 01 9Z99Z NO ITEM U R  0.00 0.0000   

0077 01 9Z99Z NO ITEM U R  0.00 0.0000   

       Category 01 Total: 279,125.60  

 ROADWAY ITEMS     

  EROSION CONTROL ITEMS      

0026 02 2L05A SILT FENCE LM R 310.00 5.0000 1,550.00  

0027 02 2L22C INLET FILTERS U R 3.00 50.0000 150.00  

0028 02 2L26C INLET PROTECTION, HAYBALE 

BARRIER 

U R 1.00 50.0000 50.00  

0029 02 2L20F CONSTRUCTION DRIVEWAY MGR R 173.00 15.0000 2,595.00  

0030 02 2L03H HAYBALES U R 40.00 5.0000 200.00  

0033 02 3B08E COARSE AGGREGATE, SIZE NO. 8 CM R 1.00 70.0000 70.00  

0066 02 8H60C FERTILIZING AND SEEDING, TYPE 

F 

SM R 77.00 1.0000 77.00  

      Category 02 Total: 4,692.00  

 ROADWAY ITEMS     

  LANDSCAPE - GENERAL ITEMS       

0064 03 8F04C TOPSOILING, 100 MM THICK SM R 695.00 4.0000 2,780.00  

0065 03 8H23C FERTILIZING AND SEEDING, 

TYPE A-3 

SM R 695.00 1.0000 695.00  

0067 03 8K31C STRAW MULCHING SM R 772.00 0.4500 347.40  

0068 03 8N05B NONVEGETATIVE SURFACE, 

BITUMINOUS CONCRETE 

SM R 88.00 28.0000 2,464.00  

0070 03 9Z99Z NO ITEM U R 0.00 0.0000 0.00  

      Category 03 Total: 6,286.40  

 CONSTRUCTION ENGINEERING ITEMS   

0004 04 1E41E FIELD OFFICE TYPE C SET-UP U R 1.00 20,000.0000 20,000.00  

0005 04 1E41F FIELD OFFICE TYPE C 

MAINTENANCE 

MO R 18.00 1,000.0000 18,000.00  

0006 04 1E31G TELEPHONE SERVICE LS R 1.00 5,000.0000 5,000.00  

0007 04 9Z99Z NO ITEM U R 0.00 0.0000 0.00  

0008 04 9Z99Z NO ITEM U R 0.00 0.0000 0.00  

      Category 04 Total: 43,000.00  

 NON-PARTICIPATIONG ITEMS     

0012 05 1G13I OWNER‟S AND CONTRACTOR‟S 

PROTECTIVE LIABILITY 

INSURANCE 

LS R 1.00 2,500.0000 2,500.00  

      Category 05 Total: 2,500.00  

     Road Total: 335,604.00 
 

Note: Extended amounts marked with “*” and items Not Carry to Proposal are not included in totals 
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Preliminary Engineer’s Estimate 

DP Number:   96802 Route:  Section:  Region:  North   Spec Year: 1996 

 

 Project: MADISON AVENUE BRIDGE OVER HACKENSACK RIVER;  Current Bid Price File: 

BRIDGE REPLACEMENT AND ROADWAY WIDENING;    02/03/1998 

BOROUGHS OF ORADELL AND NEW MILFORD, BERGEN COUNTY.   Federal Project Number: 

FEDERAL PROJECT NO. BRM-8482(104).           BRM-8482(104) 
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 BRIDGE ITEMS 

  STRUCTURE # 0200-38C 

  MADISON AVE. BRIDGE OVER HACKENSACK RIVER 

  STRUCTURE TYPE X081 

0078 06 2A31C CLEARING SITE, BRIDGE LS B 1.00 80,000.0000 80,000.00 

0079 06 2F12E FOUNDATION EXCAVATION CM B 265.00 70.0000 18,550.00 

0080 06 2F21F COFFERDAMS LS B 1.00 20,000.0000 20,000.00 

0081 06 5A21A CONCRETE IN STRUCTURES, FOOTINGS CM B 150.00 260.0000 39,000.00 

0082 06 5A31A CONCRETE IN STRUCTURES, RETAINING 

WALLS 

CM B 90.00 550.0000 49,500.00 

0083 06 5A12B CONCRETE IN SUBSTRUCTURES, 

ABUTMENT WALLS 

CM B 125.00 450.0000 56,250.00 

0084 06 5A13C CONCRETE IN SUPERSTRUCTURE, DECK 

SLABS 

CM B 125.00 450.0000 56,250.0 

0085 06 5A23C CONCRETE IN SUPERSTRUCTURE,  

SIDEWALKS 

CM B 5.00 500.0000 2,500.00 

0086 06 5A33C CONCRETE IN SUPERSTRUCTURE, 

PARAPETS 

LM B 56.00 300.0000 16,800.00 

0087 06 5A21E REINFORCEMENT STEEL IN STRUCTURES KG B 9,900.00 1.6000 15,840.00 

0088 06 5A31E REINFORCEMENT STEEL IN STRUCTURES, 

EPOXY COATED 

KG B 6,500.00 2.0000 13,000.00 

0089 06 5A31G EPOXY WATERPROOFING SEAL COAT SM B 60.00 20.0000 1,200.00 

0090 06 5A30H 65 BY 65 MM PREFORMED ELASTOMERIC 

JOINT SEALER 

LM B 27.00 65.0000 1,755.00 

0091 06 5A21L SAWCUT GROOVED DECK SURFACE SM B 150.00 15.0000 2,250.00 

0092 06  PRECAST CONCRETE ORNAMENTAL CAPS U B 4.00 1,250.0000 5,000.00 

0093 06  PRESTRESSED CONCRETE BOX BEAM, 1,220 

BY 686 MM 

LM B 145.00 550.0000 79,750.00 

0094 06  PRESTRESSED CONCRETE CHANNEL BEAM, 

1,220 BY 686 MM 

LM B 16.00 600.0000 9,600.00 

0095 06 5C19A STRUCTURAL STEEL LS B 1.00 23,760.0000 23,760.00 

0096 06 5C22D STRUCTURAL STEEL DECK JOINTS LS B 1.00 3,080.0000 3,080.00 

0097 06 5E19B TEST PILES LM B 70.00 200.0000 14,000.00 

0098 06  STEEL PIPE PILES, 305 MM DIAMETER LM B 1,170.00 95.0000 111,150.00 

0099 06 5E21M FURNISHING EQUIPMENT FOR DRIVING 

PILES 

LS B 1.00 42,500.0000 42,500.00 

0100 06  METAL RAILING (STEEL) LM B 60.00 200.0000 12,000.00 

 

Note: Extended amounts marked with “*” and items Not Carry to Proposal are not included in totals 
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 Project: MADISON AVENUE BRIDGE OVER HACKENSACK RIVER;   Current Bid Price File: 

BRIDGE REPLACEMENT AND ROADWAY WIDENING;            02/03/1998 
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0101 06  150 MM GAS MAIN SLEEVE LM B 31.00 300.0000 9,300.00 

0102 06  405 MM TEMPORARY WATER MAIN LS B 1.00 100,000.0000 100,000.00 

      Category  06  Total: 747,785.00 

      Bridge Total:   747,785.00 

      Grand Total: 1,083,389.00 

 

Note: Extended amounts marked with “*” and items Not Carry to Proposal are not included in totals 

 


